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AIMS — Baramati

Vision:
To develop multidimensional business leaders through the blend of value based,

techno-powered and skill intensive management education

Mission:

To inculcate life skills in students through proactive involvement of all
stakeholders to lead in the dynamic business environment

Objectives:

» To provide world class technological and academic infrastructure to

facilitate intellectual transactions and enhanced technology know how.

» To establish the collaborations with national and international Corporates,
NGO’s, Academic Institutions and Government establishments for student

grooming.

» To develop business research acumen in students to cater real-time

solutions.

» To instil contemporary skills in students to lead the businesses with

sustainability approach

= To inculcate universal values in students for social wellbeing.




Programme Educational Objectives (PEOs)

1. PEO1: Graduates of the MBA program will successfully integrate core, cross-
functional and inter-disciplinary aspects of management theories, models and
frameworks with the real world practices and the sector specific nuances to provide
solutions to real world business, policy and social issues in a dynamic and complex
world.

2. PEO2: Graduates of the MBA program will possess excellent communication
skills, excel in cross-functional, multidisciplinary, multi-cultural teams, and have
an appreciation for local, domestic and global contexts so as to manage continuity,
change, risk, ambiguity and complexity.

3. PEO3: Graduates of the MBA program will be appreciative of the significance
of Indian ethos and values in managerial decision making and exhibit value
centered leadership.

4. PEO4: Graduates of the MBA program will be ready to engage in successful
career pursuits covering a broad spectrum of areas in corporate, non-profit
organizations, public policy, entrepreneurial ventures and engage in lifelong
learning.

5. PEOS: Graduates of the MBA program will be recognized in their chosen fields
for their managerial competence, creativity & innovation, integrity & sensitivity to
local and global issues of social relevance and earn the trust & respect of others as
inspiring, effective and ethical leaders, managers, entrepreneurs, intrapreneurs and
change agents.




Academic Policy 20232024

The Curricular Delivery is the mainstay of the institute's Academic and Administrative
process. Anekant Institute of Management Studies (AIMS) is a teaching institute
affiliated to Savitribai Phule Pune University, Pune and follows its legal framework for
legitimizing its academic and administrative processes.

Planning:

1.

Institute plans for the academic committee meeting, scheduled before the start of the
session. The syllabus review, course allocation, workload allocation, course file
content, comprehensive concurrent evaluation plan, academic calendar. The
important points related to Programme Educational Objectives (PEOs), Programme
Outcomes (POs), Programme Specific Outcomes (PSOs), Course Outcomes (COs),
comprises the points of discussion of the meeting.

The main focus is on the preparation of teaching plans for the allotted courses. The
teaching plan contains methodology of teaching, detailing regular sessions and
presentations on reading materials, assignments and class tests.

Institute plan for an orientation program for newly admitted students at the start of
the actual academic session. The program helps students familiarize with institute
academic culture, administrative practices, syllabus review, Outcome Based
Education (OBE) system, curriculum plan, examination pattern, code of conduct,
industry requirement.

Planning for industrial Visits (local and out of state), expert talks, events and
activities in which experts from industry and academics participate in our curriculum
delivery process to bridge the gap between industry and academia.

Planning for allotment of mentors to students and development of Mentor-Mentee
system for student competency development and Guide allocation for Project
internships, issues in academics, as well as administration, is practiced.

Implementation:

University has designed Choice Based Credit System (CBCS) and Grading System
Outcome Based Education pattern which Institute follows in its curriculum.

Institute follows a cafeteria approach by providing Generic Core/Elective subjects
every semester. The students have the flexibility to choose any one specialization
from specializations offered in the university syllabus. The students are well
explained in the orientation program about the specialization offered.

The delivery of course sessions carried out as per time table. Faculty adopts the
advanced teaching methodology in delivery of course sessions. Faculty focuses on
quality delivery and encourages student’s active participation in the entire curriculum,
curricular and extracurricular activities. This is reflected in the course files as
evidence of institute teaching pedagogy.




Anekant Education Soclety's

~ Anekant Institute of Management Studies, Baramati

Approved by DTE, Gov. of Muharashtrn, AICTE & Affiliated to SPPU

Academic Calendar-SEM-I (A. Y, 2023-24)

August
Je |
1 3 4 5
7 8 9 10 11
14 16 18
21 22 24 25
September N
1 2
11 12 13 14
18 19 20 21 22
26
October
9 10 11 12 13
17 18 19 20 21
30
November
1 2 3
6 7 9 10
December
Mon e
1 2
4 5 6 il 8 9
11 12 13 14 15 16
18 19 20 21 22 23
25 26 27 28 29 30

Dr.ﬁ:. More

Program Coordinator

Activities

DPM & TVC
| Course Teachers |

Conclusion of Semester-I |

Course Teachers

| December |SPPU Examinalions l

CEO

Colour Actlvities

Academic Activities

Co-Curricular Activities

Clubs Activities

Training, Placement & Student Support

Di. M. A. Lahori
Dircctor




Anekant Education Society’s
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Anckant Education Society Campus, Baramati, Dist.Pune

Date: 16/08/2023

NOTICE

Academic Year 2023-24
MBA — First Year, Batch XIII (2023-25)
SEMESTER 1

All MBA First year students are hereby informed that, Institute is starting
Certificate Course in Information Technology from Saturday 19" August 2023.
The course is institute based and comes under the umbrella of Add on Course. The
last date for registration of course is Friday, 18 August 2023. The course is free of

cost. Kindly contact the undersigned for the registration of the course.

/4
Dr. M. A. Vhora

Course Teacher




Anekant Education Society’s
ANEKANT INSTITUTE OF MANAGEMNET STUDIES (AIMS)
Baramati, Pune

Academic Year 2023-24
MBA —First Year, Batch 2023-25
SEMESTER 1
Course Code & Title: (Add on Course 01) Information Technology

Syllabus
Course Description

The course is primarily student professionals looking to add research skills to their skills profile.
The course will also be of utility for learners who may do research tasks as part of their jobs such
as business developers, and entrepreneurs, or for people looking to explore research as a career
change option. This course provides graduates with a competitive edge in the analytical skills.

Course Objectives

1) To understand all the hard work and process of conducting internal, secondary, and
primary research.

2) To know the techniques of analyzing all the data and are able to formulate insights and
recommendations based on your research proposal.

3) To learn the best way to present findings and be able to make a decision. Researcher will
choose the most effective analytical method for delivering insights and the best
presentation method for given audience. It will help to incorporate data visualization best
practices and use tips and tricks when presenting to r various levels of decision makers.

Course Outcomes

Upon satisfactory completion of this course, the student should be able to;

» Describe and analyze the hardware, software, components of a network and the
interrelations.

> Develop solutions for networking and security problems, balancing business concerns,
technical issues and security.

» Explain concepts and theories of networking and apply them to various situations,
classifying networks, analyzing performance and implementing new technologies.

> Explain the concepts of confidentiality, availability and integrity in Information
Assurance, including physical, software, devices, policies and people. Analyze these
factors in an existing system and design implementations.




Teaching Pedagogy

Lectures: The basic concepts and theories of the course content are introduced in lectures.
Case studies and practical Examples are provided.

Practical: Actual problem given in the practical sessions and resolved during the sessions.
Interaction with various survey are made them confident about research issues.

Course Evaluation:

This course is of 100 marks out of which Internal Descriptive Examination will be conducted
for 50 marks and concurrent evaluation will be carried out for 50 marks. On successful
completion of course, the marks will be converted in to grades based on following criteria.

Sr.No | Marks out of 100 Grade
1 Less than 40 F

2 40-50

3 50-60

4 60-70

5

6

70-80
80 & Above

o »| W O T

101 - INFORMATION TECHNOLOGY

1. Introduction to Computers: Hardware - Software - Systems Software, Application Software
and Packages - Introduction to Embedded Software. Fundamentals of operating system-
Windows, Unix/Linux. Introduction to World Wide Web -

Internet operations. Emerging communication technologies

2. Software Packages

2.1 Microsoft Word — Mail merge (2)

2.2 Microsoft Excel — Formulas, Graphs, Basis statistical formulae. 4)

2.3 Microsoft Power Point — Creating effective presentations 4)
2.4 Microsoft Access - Introduction to DBMS concepts, Creating a database,

Basic queries. (6)

2.5 Tally — Journal Entry, Ledger posting, Preparation of Balance Sheet (6)

3. HTML - Home page designing for each student using Microsoft FrontPage. 4




Books Recommended:-

1. Rajaraman, V. (2004). Introduction to Information Technology. PHI.

2. Turban, Rainer and Potter (2003). Introduction to information technology. John
Wiley and sons.

3. Sinha, P.K., Priti Sinha (2002). Foundation of computing. BPB Publications.
4.Ram, B. (2003). Computer Fundamentals. New Age Publications

\ 4
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Anekant Education Society’s
ANEKANT INSTITUTE OF MANAGEMNET STUDIES (AIMS)

Baramati, Pune

Academic Year 2023-24

MBA -First Year, Batch 2023-25

SEMESTER I

Course Code & Title: (Add on Course 01) Information Technology

Lesson Plan

1. Type of Course: Add on Course
2. Name of Faculty: Dr. M. A, Vhora
3. Session Allotment: 2:0:2 (1 Hour a Session and 2 Sessions Per Week)
4. Methodology of Teaching: Regular Sessions and Practical
Month Unit | L:T:P Particular No. of
/Sub Sessions
| Unit allotted
August 1.1 L Hardware - Software - Systems Software 1
1.2 L Application Software and Packages 1
1.3 L Fundamentals of operating system- Windows, 1
Unix/Linux.
1.4 L Introduction to World Wide Web 1
1.5 L Internet operations. Emerging communication 1
_technologies
September | 2.1 P Microsoft Word — Mail merge 2
2.2 P Microsoft Excel — Formulas, Graphs, Basis 4
B statistical formulae.
23 P Microsoft Power Point — Creating effective 4
B presentations
October | 2.4 P Microsoft Access - Introduction to DBMS 4
B concepts, Creating a database, Basic queries.
2.5 P Tally — Journal Entry, Ledger posting, 6
Preparation of Balance Sheet
November 3.1 P HTML - Home page designing for each student 5
. using Microsoft FrontPage
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Anekant Education Society’s

Anekant Institute of Management Studies (AIMS) Baramati, Pune

Academic Year 2023-24

MBA —First Year, Batch 2023-25

SEMESTER 1

Course Code & Title: (Add on Course 01) Information Technology

List of Enrolled Students

All MBA First year students are hereby informed that, Institute is starting

Certificate Course in Information Technology from Saturday 19" August 2023.

Following students are registered for the same.

N

Sr. No Name of the Student Signature
A02310101 |[ABNAVE RUTUJA SUNIL | Hleed.
A02310102 | AGAWANE RUSHIKESH SANJAY Hgpen~
A02310103 | ATTAR MUJEMIL ASHFAQ sad
A02310104 | BANKAR DHIRAJ RAMDAS Naiva] & -
A02310105 | BANKAR PRERANA PANDURANG Bantol.

| A02310106 | BHAGAT NIKITA RAJARAM [AA o du
A02310107 | BHOSALE SHRADDHA DADADO Ao :
A02310108 | BHUNJE VAISHNAVI RAJENDRA -’EMA
A02310109 | BORATE SIDDHI SATISH ) Ciddwl-
A02310110 | BULBULE KARTIKEY RAMAKANT "ﬁ

| AO2310111 | CHAKHALE ASHISH KANTILAL

| AO2310112 | CHAVAN PRATIKSHA NITIN Mcme

A02310113 | CHAVAN PRIYANKA SANDESH ) ~cwf‘_u,m B
A02310114 | DHAPATE OM JANARDHAN R 2Te
'A02310115 | DHAVALE RAHUL MARUTI =z
A02310116 | DHAWAN SHITAL PRAMOD Qhﬁﬁmuw
A02310117 | DHOTRE ADITYA ASHOK 24i6eH eﬁm
A02310118 | DHUMAL PRATHAMESH SUNIL A R bhenoh
A02310119 | DOSHI ASHAY RAJKUMAR | FDosin Esuﬂ -
A02310120 | KSHIRSAGAR SONAL PRAKASH jp.,t:j —
A02310121 | KUDALE SAGAR RAJARAM ;%g/" A

A02310122 | KSHIRSAGAR SONAL PRAKASH doualK -

A02310123 | KUDALE SAGAR RAJARAM 1SR Kghe

L] v

e

Dr. M.A. Vhora
Course Teacher




Academic Year: 2023-2024

Anekant Education Society's
ANEKANT INSTITUTE OF MANAGEMENT STUDIES

Class: MBA First Year
ADD on Course Name : Information Technology
Name of the Faculty : Dr. qulsha Vhora

ATTANDANCE SHEET

Anekant Education Society Campus, Baramati, Dist-Pune-413102.

S

Batch : XIII 2023-25

emester: [

SEN| b iNe Name of the Student / Date[\119 |27 2118)22 [2¢)8125 |28 (812g [2\d T2 | AL\2S[ gy (23] o[l [ (¢ 42 Blalad
0. ’ & Lect.No.| | 9 . ]2} Giy,_3 < C 7 8 . q lo
1 | AO2310101 [ABNAVE RUTUJA SUNIL |[(Asl |@sed| Al (gHemd | pg (Aips) I%Lﬁ’é‘} o) AR |eHd
2 | AO2310102 |AGAWANE RUSHIKESH  |Musi | ACwmlby pe | Aty | A0 | Atw, | AF Al AP | At
3| A02310103 [ATTAR MUJEMIL = Kol | Lod |G, |Saof | 8 |-&d |l [Bedf
4 | AO2310104 [BANKAR DHIRAJ BR [ BPhi | o3 |pOniver | AB |EDhira [BPhiyed AR |Bbhiyar | BDhiyes
5 | AO2310105 |BANKAR PRERANA o b 5 itV 0% | fepnl P N A
6 | AO2310106 [BHAGAT NIKITA Aoy o N1 | Tk AR | twower™N | “pp BrowatO | PB_ | flasq st
7 | AO2310107 |[BHOSALE SHRADDHA PR P B A | py s AR pR P I Y.
8 | A02310108 [BHUNJE VAISHNAVI P8 [ypwm<|[vihwid AS VBhond Vnoni | pg (VPhenic | B, | UBbente
9 | A02310109 |BORATE SIDDHI SATISH @Muvst— P8 | mary P A8 Bl et P Y LS frovidkt | s
10 | AO2310110 [BULBULE KARTIKEY pp | PO | pB Ao ./ pe | PD pQ
11_| AO2310111 |CHAKHALE ASHISH b Uw“‘ Av_ QLW Aahal]  AB NGl T - hadel o chJO U6 ch.
12 | A02310112 | CHAVAN PRATIKSHA adiiin] Bkt PO lfakiiha|l PP |Liokivoha | Pabionel P
13 | AO2310113 | CHAVAN PRIYANKA rm Py [pchedledwwan| pp Jv.ovoon [pehwen| A ([
14 | AO2310114 | DHAPATE OM OV DOm0 [ OnmD | Om O | PE [HmO: PP | Omo | pyd
15 | AO2310115 | DHAVALE RAHUL AB  [prowdD [ PB [gohwin| PE | Kot | @obun, | PB  Wehelp,
16 | AO2310116 | DHAWAN SHITAL AB YW O] Auyer | DB [l PY [Qayein. | Chiteb| Akl
17 | A02310117 | DHOTRE ADITYA Ap PE NPt ADMIM]. ap [ADvwel P2 |ppbobe | Aphetie
18 | AO2310118 | DHUMAL PRATHAMESH| 7 | B 3 PP | Dhakn| PP DPih | Dl |DPai | pa
19 | A02310119 | DOSHI ASHAY ALl A Dochi | pr (A Dok [ADoahi|l  pe |Advgs | ADoch; pg
20 | AO2310120 | KSHIRSAGAR SONAL  [(taalic | Seval & |Gtk | concth - | Goualk | Sonedk | Gued i |
21 | A02310121 | KUDALE SAGAR [ AR PB [ pradal [Chodatt | rudd g eudstd | oy pdate
22 | A02310122 | KSHIRSAGAR SONAL XS0 ot | K coned B |xgnt | p8 [KSonad
23 | A02310123 [KUDALE SAGAR __S. Kiyggh 1S Ky | ¢ skuele | o Rud) s kol s kodedet
Total No. of Present Students: N \ ;L [ 20 lo (3 (%
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Academic Year: 2023-2024 |

Anekant Education Society's
ANEKANT INSTITUTE OF MANAGEMENT STUDIES

Class: MBA First Year
ADD on Course Name : Information Technology
Name of the Faculty : Dr. Manisha Vhora

ATTANDANCE SHEET

Anekant Education Society Campus, Baramati, Dist-Pune-413102.

S

emester: 1

Batch : XIII 2023-25

TRy

SEN| b Ne Name of the Student / Date[23\q 123 | &5\ [ 30 1L] Slo 122] Z o 1f F)lo( 2D 1“‘-""-’5 reflofw u”"" 22| w2llelD
0. ' & Lect.No. [ 12 13 LG (- L& \3 27

1| AO2310101 |[ABNAVE RUTUJA SUNIL | Ak | dled. 1/ el | Gied ~ /M"ﬂl pe howet
2 | AO2310102 |[AGAWANE RUSHIKESH | {Aqawfw [ {{pqowen | Lheemim|pgaoace |§RGanar] {gamwane | fhnmns o] (Agemenc %f P .
3 | A02310103 |[ATTAR MUJEMIL #8 | Sl | L] [ St [ £ [l ’géA el =20
4 | A02310104 [BANKAR DHIRAJ B Dhisa) | B: Dhise ?&-oqu 13Dy |3 Dhitad| B: Dhiaey |Br Dhinoyy }z-oh;naj i l)h-lm:; B Dhisg |
5 | AO2310105 |BANKAR PRERANA Lapteat, k] AP 2 | popparl s Eé% PP V7
6 | A02310106 |BHAGAT NIKITA pi —ﬁ%" Ay C:%l'kﬂt\ Nikite | f8 | Nikita AT | Nikita g«% i
7 | AO2310107 |BHOSALE SHRADDHA | Qlusicsod| Qa8 | (6 |Clunetdlid | qutccetb| o g PGB | fhaaddbb | Ol addint | Plyasdding
8§ | AO2310108 [BHUNJE VAISHNAVI Viahonie| VBl Laheid BB VBl VBt PP | Vet @b VBbonge
9 | A02310109 |BORATE SIDDHI SATISH ewend | 00 Hawl Za Bl 00 |t [rmand |G | D
10 | A02310110 [BULBULE KARTIKEY : P PG r 02 khagdtblabd pnt K bL ‘{&E@p)u/ ap
11 | AO2310111 |CHAKHALE ASHISH 8 an A 8 " | an BO hp By Po
12 | AO2310112 | CHAVAN PRATIKSHA GBuame Chouhivs | po [Lhahiid PO |Lhaivin | CObittn] Clahiha] | Olp | C-thig
13 | AO2310113 | CHAVAN PRIYANKA  |[Lwn boor Pann Pan pg | Pa— Pure e {oal 4

14 | A02310114 | DHAPATE OM dgpow\o D | PP | a0 | Ol | g | 0D, [ oo | Ondp AB

15 | A0O2310115 | DHAVALE RAHUL RahulP | Ranv) D] painud-d ot D AP [lopdil] , pB  [Raido. AD
16 | AO2310116 | DHAWAN SHITAL BhaventP. ] o m% SOave] 0% L phvuern bk Dluen] Pt DR
17 | AO2310117 | DHOTRE ADITYA ey TAO— T . PO | AR Ao m~ | A | AB—
18 | A02310118 | DHUMAL PRATHAMESH|F Dk pe RO P DJNM o D Pg ek o BhaimeA 78

19 | AO2310119 | DOSHI ASHAY L " pe | pn pe | . po } e | Py [ po _
20 | A02310120 | KSHIRSAGAR SONAL _SM/ P8 | Kgpptlic m,.,:j/ P [stEl, @mm// ol
21 | A02310121 | KUDALE SAGAR Qmw Choarl g " | ol o | (yumdede ;’\c D
22 | A02310122 | KSHIRSAGAR SONAL WAL | gl pg | @ | g | Canedle| PR [Guefic
23 | A02310123 [KUDALE SAGAR il Jethb—]  pp <Kol ). w3 skeoli]  ps

Total No. of Present Students: 20 ‘ 3 1O \2 ]2,_ ‘O( U/ \S
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Academic Year: 2023-2024

Name of the Faculty : Dr. Manisha Vhora

Anekant Education Society's
ANEKANT INSTITUTE OF MANAGEMENT STUDIES

Class: MBA First Year
ADD on Course Name : Information Technology

Anekant Education Society Campus, Baramati, Dist-Pune-413102.

S

Batch : XIII 2023-25 |

emester: I

| ATTANDANCE SHEET

Sr.N e Name of the Student / Date|3\\0|2 2 Solte\2a [ ayfpo\a| blv agf 6Tty [t | BTy [2eT0T 4 ’thll‘f?} LTIt 2y
0. ' . & Lect.No.| 9 L. | 54 2l 2 | 26, | 27 |y e 20
1 [ A02310101 [ABNAVE RUTUJA SUNIL k%f_ o] Ll o A&ed [ Pgsu ] | Absed. (L] (o]
2 | A02310102 [AGAWANE RUSHIKESH wih [ o[ 2o oo PR 1B po - [PW | PR | Ay
3 | A02310103 |ATTAR MUJEMIL Ll %ﬁ el | el |G T\ |2l |meh- | Ap
4 | AO2310104 [BANKAR DHIRAJ e 2| vl | pu PR | s | fazn | (| Al | AR
5 | AO2310105 |[BANKAR PRERANA bl | Geptosl | pantend %M | Jeppcrf0 m %{ A 1|~
6 A02310106 [BHAGAT NIKITA N8 Y AdNBE T pe Fyone |0) PE | aFPB [ onn
7 | AO2310107 |BHOSALE SHRADDHA N AVes M pp )CUJ&\MU KA 6o N e ls L,}_ﬁwﬂ\, — "(M DR
8 | A0O2310108 |BHUNJEVAISHNAVI | A p| pg. aeghe [Vern A AN P load A | veuw oot yaX | An
9 | A02310109 [BORATE SIDDHI SATISH (gl |—Farw) g@[ —5. e £Bmer @i,
10 | A0O2310110 [BULBULE KARTIKEY 1. ¢ Y Ay | PR o a P8 | o | RSB
11_| AO2310111 |CHAKHALE ASHISH Lhadedlachdul 73 J\M | o8 POk -kl 2 2
12 | A02310112 | CHAVAN PRATIKSHA |- 7 Ag | AR o | PRC | PR [P Tpec| B | Teec|RB [ Ag
13 | A02310113 | CHAVANPRIYANKA  ledyionn [0 Mueim| P2 by [Peluun] P8 ,«JJM\,&(M,“ L Kchu
14 | AO2310114 | DHAPATE OM | pe Ba [30n | AT v pg P B MM b 1wy
15 | AO2310115 | DHAVALE RAHUL L. pg v MU AT AT T AT S MM
16 | AO2310116 | DHAWAN SHITAL <0 a0l SDhaven| 50 5 Do dobhauom M isDhaiopry | $bhasma| 1 |5 Aot
17 | A02310117 | DHOTRE ADITYA AD A PO e | AD At | AN AL,
18 | AO2310118 | DHUMAL PRATHAMESH| /A4~ /.M-ﬁ» fopptell— fovehd— 7 oo 24 L. gervees i p el 0. papl p . perel
19 | AO2310119 | DOSHI ASHAY K j)m_ Y D,SL /\ Yy / R Ty
20 | A02310120 | KSHIRSAGAR SONAL 13 ) A0 AQ, j
21 | AO2310121 | KUDALE SAGAR | {iu{:_‘:l-’ Lodi- Skl ,a,q?z#nffe- -
22 | A02310122 | KSHIRSAGAR SONAL v A0 Slda Al py
23 | A02310123 |[KUDALE SAGAR 1S Fdnte T ¢ petrvdbe] < lepder] ¢ oyclath AB

Total No. of Present Students:




Anekant Education Society’s
ANEKANT INSTITUTE OF MANAGEMNET STUDIES (AIMS)

Baramati, Pune

Academic Year 2023-24
MBA —First Year, Batch 2023-25

SEMESTER 1

Course Code & Title: (Add on Course 01) Information Technology

Course Completion Report

1. Type of Course: Add on Course
2. Name of Faculty: Dr. M. A, Vhora
3. Session Allotment: 2:0:2 (1 Hour a Session and 2 Sessions Per Week)
4. Methodology of Teaching: Regular Sessions and Practical
Session Date Time Content No of
No Students
1 19/08/2023 | 430.5.30 pM | Hardware - Software - Systems 18
Software
2 21/08/2023 | 4.30-5.30 PM | Application Software and Packages 18
3 26/08/2023 | 4.30.5.30 pM | Fundamentals of operating system- 20
B Windows, Unix/Linux.
4 28/08/2023 | 4.30-5.30 PM | Introduction to World Wide Web 18
5 02/09/2023 | 4.30.530 PM | Internet operations. Emerging 18
- communication technologies
6 | 04/09/2023 | 4.30-530PM | Microsoft Word — Mail merge 17
7 09/09/2023 | 4.30-5.30 PM | Microsoft Word — Mail merge 21
8 11/09/2023 | 430-5.30 PM | Microsoft Excel — Formulas, Graphs, 17
Basis statistical formulae. .
9 16/09/2023 | 430.530PM | Microsoft Excel — Formulas, Graphs, 21
| Basis statistical formulae. -
10 18/09/2023 4.30-5.30 PM | Microsoft Excel — Formulas, Graphs, 18
Basis statistical formulae.
11 23/09/2023 | 4.30-5.30 pM | Microsoft Excel — Formulas, Graphs, 18
| . Basis statistical formulae. B
12 25/09/2023 | 4.30-5.30 PM Microsoft Power Point — Creating 18
- effective presentations
13 | 30/09/2023 | 430.530pM | Microsoft Power Point — Creating 14
L effective presentations
5




14 03/10/2023 | 4.30-5.30 PM | Microsoft Power Point — Creating 17
effective presentations
15 07/10/2023 | 430.5.30 PM | Microsoft Power Point — Creating 17
effective presentations
09/10/2023 Microsoft Access - Introduction to
16 4.30-5.30 PM | ppMmS concepts, Creating a database, 18
Basic queries.
14/10/2023 Microsoft Access - Introduction to
17 4.30-5.30PM | pBMS concepts, Creating a database, 18
Basic queries.
16/10/2023 Microsoft Access - Introduction to
18 4.30-5.30PM | pBMS concepts, Creating a database, 18
Basic queries.
21/10/2023 Microsoft Access - Introduction to
19 4.30-530PM | pBMS concepts, Creating a database, 15
Basic queries.
23/10/2023 Tally — Journal Entry, Ledger posting, 16
20 4.30-5.30 PM Preparation of Balance Sheet
21 28/10/2023 | 430-5.30 pM | Tally — Journal Entry, Ledger posting, 18
Preparation of Balance Sheet
22 30/10/2023 | 430-5.30 pM | Tally — Journal Entry, Ledger posting, 18
Preparation of Balance Sheet
23 31710/2023 | 430.530pM | Tally —Journal Entry, Ledger posting, 17
Preparation of Balance Sheet
24 04/11/2023 | 430-530 pM | Tally —Journal Entry, Ledger posting, 18
Preparation of Balance Sheet
25 06/11/2023 | 430.530 pM | Tally —Journal Entry, Ledger posting, 18
Preparation of Balance Sheet
26 11/11/2023 | 430-5.30 pM | HTML — Home page designing for each 19
student using Microsoft FrontPage
27 18/11/2023 | 430-530 M | HTML — Home page designing for each 18
B student using Microsoft FrontPage
28 20/11/2023 | 430.5.30 pM | HTML — Home page designing for each 17
student using Microsoft FrontPage
29 24/1172023 | 430-530 M | HTML — Home page designing for each 18
student using Microsoft FrontPage
30 25/1172023 | 4130.5.30 pM | HTML — Home page designing for each 19

| student using Microsoft FrontPage
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Anckant Education Society’s
Anekant Institute of Management Studies (AIMS) Baramati, Pune

Academic Year 2023-24
MBA —First Year, Batch 2023-25
SEMESTER I
Course Code & Title: (Add on Course 01) Information Technology

QUESTION PAPER

WORD, EXCEL, POWERPOINT, MS ACCESS

Fill in the blanks

1. Using ---------- it is possible to sent mails to more than one person. (MailMerge)
2. In Excel --------- automatically creates sum (Autosum)

3. To cancel the last editing, we use the ------- button (Undo)

4. Calculations can be performed through----------- (Excel)

5. A cell with dark border around it is called -------- cell (Active)

6. The Mail merge option is in -------- menu (Tools)

7. The short cut key for slide show is--------- (F5)

9. e is the background on which different windows appear (Wall paper)

10. -------- shows the name of the application, document, groups or directory (Folder)

11, —=mmemeee is a quick and easy way for mass production of letters, envelops, mail labels etc..
(Mailmerge)

12. The --------- features helps you to avoid making typing mistakes and speed up your typing.
(Spelling and grammar)

13. The extension of a Power Point is --------- (ppt)

R function will return the largest value in the selected range of cells (MAX)

15. The ------- option issued to undo the previous action (Undo).

16, ~eeenenen positions the text according to the margins (Ruler)

17. A set of programming statements Iis called--------- (macro)

18. Ctrl+S is the shortcut key for -——-‘-'-"--'-(sa\"/e) '

FALSE (SUMIF) d &

20. In Power Point F5 is used for------- (View show)




21. The short cut key for spell check in MS Word 18 —=-mmmeme (F7)
22. Ctrl+V is the shortcut for------v--- operation (Paste)

24. An individual page in a Power Point presentation is called -------- (Slide)

25. A-memeeme is used to set the page margins, change paragraph alignment and spacing (Indent)
26. Ctrl+V is the shortcut for ------ (Paste)

27. The shorteut for italics is =-----nno- (Ctrl+1)

28, e is an example for copy is ~-----n-- (Ctrl+C)

29. In Excel replace option is in -=----- menu (Edit)

30. The key for spell check in MS Word i§ ~------ (F7)

31. In Power point short cut key is insert new slide is =------ (Ctul+M)

32. In Excel, the intersection of row and column is known as -------- (cell)

33, e is an example for Data base Management system (MS Access)

34, oo displays the location of the active cell and the value or formula used in the active cell

35, e function will return the largest value in the selected range of cells (MAX)

36. A set of programming statements is called ------ (Macro)

37. Go to option is in -----=--- menu (Edit)

38, e adds the cells specified by a given condition or criteria ( IF )

39. In MS Word, Change Case is in «------- menu (Format)

40. In MS Excel, Macro is in ~------- menu (Tools)

41. In MS Excel, an individual file is known as -----. (Workbook)

42. MS Excel is an example for -------- program (Spreadsheet)

43. In MS Word, print is in ------- menu (File)

44, - acts a document with preset text and formatting using which a new document can be
made (Template)

45, -emeeen can be used to copy character and paragraph formatting from one place to another.

(Format Painter)

46. ---maev is a text alignment type (Justify)

47, e define the left and right side margin of a paragraph (justify)

48. ﬁi’%f:{fc?e-—- helps you to fill rows or columns with a series of data (Auto fill)
;4'"':' T -;‘{?_T{l{mlion return smallest value in a selected range of cells. (MIN)




50. --——---- is a data type in MS Access. (Currency)

51. Formula in MS Excel begin with ------ sign (=)

52. You can customize the range of Sheets to be displayed in startup as 1 to ---- (10)
53. In Access------ formats the printed information (Report)

54. - is a complete collection of data displayed in rows & columns. (Tables)
55. --—--- is a program that helps to create slide presentations quickly (Power Point)
56. Delete slide option is in ------- menu (Edit)

57. Clip art is a collection of ------- files (graphic)

58. Picture option is in ------ menu (Insert)

59. In MS Word merge cell is in ------ menu (Table)

60. Maximum number of columns in Excel is ------ (256)

61. Maximum number of rows in Excel is ------- (65536)

TRUE OR FALSE

1. A word processor is a software package that helps to create and edit a document (True)
. In word Print preview option is in File menu (True)

. Page setup option is in Table menu in MS Word (False)

. Select all the text and graphics in the working document or press Ctrl+ A ( True)

. Header & Footer option is in view menu (True)

. Maximum width of a cell is 12.75 (True)

. F1 is the shortcut for Help (True)

o0 3 N W KW

. Increase decimal buttons in Formatting toolbar is used to format no. of decimal places in a cell
containing numeric data (True)

9. Hold down Ctrl key while selecting non adjacent cells (True)

10. Merge and centre button on formatting toolbar joins selected range of cells and centres the
text in the upper left cell to it (True)

11. In MS Excel a sheet name can contain 256n0. of maximum characters (False)

12. Data menu command will generate a form with each fields vertically for a selected list of

data (True)

14. Sub Total is an example for MS Excel Add —In ( False)

15. Wrap Text option breaks a long line of text into multiple lines to fit withir



16. Copy function Tool bar button on standard toolbar is used to insert a function (False)
17. In MS Excel Header & Footer are displayed in Page Break Preview (True)

18. The key board shortcut to insert hyperlink command is Ctrl+ K (True)

19. Replace command will search for some given text in your document and replace it with
another (True)

20. Sort command in Table menu is used to arrange the data in table in ascending order (True)
21. Use Print Preview to display the document exactly it will be printed (True)

22. Drop Cap command decorates the first letter of the active paragraph with large bold format
(True)

23. Maximum zoom percentage in word document is 500 (True)

24. To close MS Word, Shift+F4 keyboard combination is used (True)

25. Power Point is a graphical software (True)

26. The shortcut key for Help is F2 (False)

27. Arithmetic calculations can be done in Excel (True)

28. Charts can be embedded in Excel sheet (True)

29. Sound can be embedded in a Power Point presentation (True)

30. In MS Access, every table must have a primary key (False)

31. Spread sheets are made up of columns and rows (True)

32. In Power point every slide contains text place holder (True)

33. Word documents cannot be saved on floppies (False)

34. Pie is an Excel chart (True)

35. It is not possible to print a slide from a Power Point presentation (False)

36. Text can be converted to table (True)

37. Shortcut key for Font Dialog is Ctrl+ D (True)

38. Tables can be created in MS Word (True)

39. Chart option is in Insert menu (True)

40. Protect document option is in tools menu (True)

41. Book mark is in Insert menu (True)

42. Maximum number of rows in MS Excel is 65536 (True)

43. The total number of columns in Excel is 257 (False)

der and-Feoter is in view menu (True)
- -5 o
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46.
47.
48.
49.
50.
51.
52.
53.
54.
55.
56.
57.
58.
59.
60.

The Undo command in the Edit menu issued to reverse actions (True)
Change case option is in the format menu (True)

MS Power Point is a Spread sheet program (False)

We cannot find and replace a particular word from MS Excel (False)
Word documents cannot be saved on floppies (False)

It is possible to protect an Excel sheet using password (True)

Auto filter is a feature in Excel (True)

It is not possible to insert an Excel sheet in a word document (False)
It is not possible to animate different parts of a slide (False)

In MS Word 'Formula' option is in Table menu (True)

Worksheet can be inserted in a word file (True)

In MS Word Merge cells is in Table menu(True)

Insert page number is in Insert menu (True)

Clear option is to clear the selected text or object (True)

Paste special option is in Edit menu (True)

SHORT QUESTIONS

[um—

. What are the major features of Power Point?

2. Explain Auto Content Wizard.

3. Explain the various options available in word for formatting paragraphs

4. Briefly explain different options available in the format menu of MS Word.

5. Write steps for inserting and deleting tab

. Explain any four functions available in MS Excel.

. How will you create a table in MS Access?

6
7. Explain the steps for creating slide in a Power Point
8
9

. What is a primary key? What is its use?

10.

What is mail merge?

11. Explain different paragraph formatting options available in MS Word

12. How can we create charts using MS Excel?

13. What are the major features of MS Word ?

14. What is Book mark?
15. What is the uses of MS Excel?

-




16. What are the features of MS Excel?
17. What is Query?
18. What are the features of MS Access?
19. Explain the steps for creating Header and Footer in MS Word
20. How we can create charts using MS Excel
21. Write short notes on mail merge
22. What are the advantages of MS Office packages?
23. Explain the following
a) SUM b) Product
24. Explain Format — cells command
25. Write Notes on (a) Scenarios (b) Data — subtotals

26. Write notes on Bullets and numbering

27. ' Boarders and shading
28. " Format — Font
29. ’ Tools — Auto correct

30. Short note on Spell check

31. Different views in MS Word

32. Explain inserting a Table

33. How we can modify the Table

34, Write short notes on changing row height and column width

35. How we can insert today's Date and time in MS Excel

36. Write steps for saving a query

37. What are the uses of 'Forms' in Ms Access?

38. Write steps for create a table using Design view

39. Steps for creating a form wizard

40. What is Reports? What the steps are for create a report using an Auto report?
41. Write steps for printing a query

42. Define Validation

43. Write steps for create a pivot table

44. What is protection? Write steps for protect your document

45.
46.




47. What is 'Comment' and what are the steps for inserting comments?

48.

Write short note on symbol and write steps for inserting symbol

50. What is Undo and Redo?

51.
52.
53.

Write short note on Header and Footer
How you can change the text alignment and what are its steps

Explain frames

54. What is sort? Write steps for sorting

3.

Write short note on subtotals? What are the steps for it

56. Write steps to save and close a slide presentation in Power Point

57.
38.

In Power Point write changing bullets and numbering

Write steps for line spacing in Power Point presentation

59. Write the steps for printing document

60. How you can add page number

ESSAYS

1.
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What is Mail merge? Explain

. Briefly explain the steps for creating a Power Point presentation

. How will you create a table in MS Access?

. What is Query? What are the different options in creating a query?
. Explain Macro? Write down the steps to record a new macro

. What are the different views in Power Point Presentation?

. Briefly explain table menu in MS Word

. What are the features of MS Excel?

. What are the uses of MS Excel?

. Explain Formatting text in Power Point presentation

. Explain some functions in Excel

. What is a chart and explain different steps for inserting a chart in Excel
. In Access briefly explain Reports

. Explain creating a table using Design view and Form wizard view

. Explain Custom animation and slide transition

. Write features of MS Access /j{'( T_Jr:‘

A
. Explain Edit menu in MS Word ) (S 8. S, ,;\



18. Explain Paragraph menu in MS Word

19. Explain Macro in briefly

20. Write all options in slide presentation

21. Explain entering and editing text in Power Point presentation
22. Explain Format menu in MS Excel

23. Explain Tools menu in MS Word

24, What are the two types of text alignment?

25. Explain Hyperlink

''''''



Anekant Education Society’s
Anekant Institute of Managements Studies (ATMS)
Baramati, Dist-Pune
Computer Lab — Practical Question Bank

Information Technology

Time: 60 Minutes Record 1 10
Skill Test 120
Total Marks : 30

MS-WORD

1. Create a document with a heading and using formatting features underline, boldface and
change the font.

2. Enter a list of at least 10 things you have to do this week. Select the list and turn on
Numbering. Select the list again and turn on Bullets.

3. Select the same list change the bullet character to some symbols.

4. Create a document on student using Find & Replace All, replace the word student in the
document with citizen '

5. Take any document check for spelling and grammar.

6. Write letter to HR Managers of five different companies requesting them to allow you to
do a summer project in their companies using Mail Merge.

7. Create and print an envelope with your return address.

8. Type a letter and create an envelope for it that you add to your document. Preview it in
Print Preview.

9. Create a document that contains several paragraphs of text. Select the text and convert it
into two columns. Balance the column length. Add a line between the columns, also add a
title that spans both the columns.

10. Create a Table Student using Table Handling feature, include five columns and five rows
taking your own data.

11. Select any table create the following
1) delete a row and a column

ii) insert a row and a column.

12. Using Student table apply auto formatting,

13. Create any document and use suffixes and prefixes, insert currency symbols etc,




MS-EXCEL

14. Create a worksheet named Patient to include the following

Patient | Patient In-Patient or | Doctor Date
No Name
Out-Patient attended

Add 5 rows .
15. Create a worksheet with the days of the week at the top and time from 9.00

To 17.00 in intervals of 30 minutes (9.00, 9.30, 10.00,,,,,,,5155555555> 17.00) use Auto fill feature
to create this worksheet

16. Create the following Student worksheet

SNo | Name | Markl | Marks2 | Mark3 | Mark4 | Mark5 | Total

Using Auto Sum calculate the total marks.

17. In above table find Maximum and Minimum marks in columns mark1, mark2, mark3,
mark4 and total.

18. Prepare a worksheet showing employee code, employee name and designation of the
software engineers working in a company XYZ. The employee code starts with increments
by one for engineer and ends with 1007. Use series fill option and fill code. Also insert
today’s date on the top of the worksheet.

19. Select student worksheet, sort the data in the descending order of total using sort option.
Using filter option, filter irrelevant data.

Create the following worksheet Salary (Enter at least 5 records)

Name Basic HRA TA Deductions | Gross Tax Net Pay
Pay

K




Assume your deductions

Gross Pay is Basic + HRA+TA-Deductions
Tax is 30% of Gross Pay

Net Pay is Gross Pay —Tax

20. In above table find the average (or mean) salary, count of employees getting less than
average salary.

21. create a bar graph for the above data
22. Create an exploded pie chart with 3-D visual effect using above data.
23. Create a column chart of employees Net Pay.

24. Create the following worksheet that shows the number of planes arriving in an airport in
the morning (AM) arrivals and in the afternoon (PM ).

Day AM Arrivals | PM Arrivals
Monday 80 40
Tuesday 65 45
Wednesday 50 75
Thursday 58 60
Friday 150 80
Saturday 40 68
Sunday 30 100

Prepare a line graph showing the daily arrivals for both AM and PM.

25. Prepare two pie charts showing the relative distribution of arrivals in the morning and the
afternoon.

26. Prepare a component bar chart showing the AM and PM arrivals versus the day of the
week.

MS-POWERPOINT

27. Create a Presentation with 5 slides about various events that take place in of your college.

28. Use Auto Content wizard to create a presentation of your choice and TS
the slides.




29. Select any presentation having a number of slides, using slide sorter to change and view

the order of slides changed.

30. Create a presentation with at least 5 slides, change the colour scheme and change the fill

for a single s

cheme.

31. In a presentation — change the font and font colour, replace the body text font with

another font.

32. Create a presentation — insert a clip Art on a single slide and then re colour the single

slide.

33. Create a presentation — insert a table from MS-WORD.

34. In a presentation — insert a sound file and replay.

35. In an existing presentation — select one or more slides — apply a new transition, change the
speed of the transition.

36. In an existing presentation select one or more slides and apply preset animations from animation

affects.

37. In any existing presentation — hide one or more slides.

38. To any existing presentation apply custom animation.

MS-ACCESS

39. Create a database College and table student with following details

Student No

Name

Department

Year of

Admission

Date of

Birth

Gender

% Marks

i) enter min 10 records

i1) Identify the primary key.

40. Create the above table using the design view.

41. Create a database Company and table employee with following details

Eno | Name

Designation

Department

Basic | Dob

Pay

Ai)_p;aised_
(Yes/No)

—
#
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i)Display those employees who are appraised.
42. Select a table from an existing database and create tabular and datasheet auto forms.
43. Select employee table arrange the data in descending order of DOB using Sort.

44. Create a database Hardware mart and table spares with the following structure

Items Price per unit Qty Total cost
Laptops 15,000 5

Scanners 10,500 4

Servers 45,600 3

Printers 8,500 2

Windows 2000 1

Software

Do the following operations
i) Calculate the total cost and replace in field total cost.
ii) Sort the data using quantity
iii) Prepare report with title

45. Create a database Book Store and table Books with the following details

'Book no | Title | Author No of Copies | Publisher | Date of Publishing

Available

Perform the following queries
1) List the data author wise
ii) List Title, Author, Publisher, No of copies
iif) List all the books of a particular author

iv) Create a label of 4 lines title, author, publisher, date of publishing and s
available,




46. Create a sales man table in a data base business containing following fields

Sales Man Name Region Target set Actual
No (N/S/E/W)

i) Calculate the difference between and actual and create a new field and enter the value.
ii) Create a report of the data.
47. In the above perform following queries
1) List those salesman who have achieved the target
ii) list sales for a particular region
iii) List name, region who have not achieved the target
48. Create a database XYZ company containing the tables
Personal(Empno, name, Dob, address, City, state, email, phone)
Business( Empno, date of joining, Dept.id, designation)
Department(Deptid, Name, Description)
i) Define Primary and Foreign keys for the above table
49. In above exercise
i) Create Forms for all the tables and add data using forms
i1) Create Reports for all three tables.
50. In the above database modify the following
1) Add the following fields

Personal ---- Country

Business ------- Salary




Anekant Education Society’s
Anekant Institute of Management Studies (AIMS) Baramati, Pune

Academic Year 2023-24

MBA —First Year, Batch 2023-25
SEMESTER 1
Course Code & Title: (Add on Course 01) Information Technology

Internal Evaluation Report

Roll No Parameters for Internal Evaluation
Name of the Student MCQ | Practi | Test | Present | Attendan | Total
cal ations ce 50
A02310101 |ABNAVE RUTUJA SUNIL 7 6 8 5 5 31
AGAWANE RUSHIKESH
A02310102 SANJAY 8 5 5 6 7 31
A02310103 | ATTAR MUJEMIL ASHFAQ 7 7 5 5 7 31
A02310104 | BANKAR DHIRAJ RAMDAS 5 5 6 5 8 29
BANKAR PRERANA
A02310105 PANDURANG 7 7 B 5 8 6 33
A02310106 | BHAGAT NIKITA RAJARAM |6 8 7 8 8 37
BHOSALE SHRADDHA
A02310107 DADADO AB AB AB AB AB AB
BHUNIJE VAISHNAVI
A02310108 RAJENDRA 7 8 7 7 34
A02310109 | BORATE SIDDHI SATISH 5 6 27
BULBULE KARTIKEY
A02310110 RAMAKANT 6 8 5 6 31
"HAKHALE ASHISH
AO2310111 C ANTILAL 6 8 7 4 6 31
AO02310112 | CHAVAN PRATIKSHA NITIN | 5 6 6 7 5 29
CHAVAN PRIYANKA
_A(_)23 10113 SANDESH 7 9 8 8 7 39
A0O2310114 | DHAPATE OM JANARDHAN | 8 6 7 8 8 37
AO02310115 | DHAVALE RAHUL MARUTI | AB AB AB AB AB AB
A02310116 | DHAWAN SHITAL PRAMOD | 8 8 7 8 8 39
A02310117 | DHOTRE ADITYA ASHOK 8 6 6 5 6 131
DHUMAL PRATHAMESH
AO02310118 SUNIL - i - 6 - 8 7 7_ | 33
A02310119 | DOSHI ASHAY RAJKUMAR 6 5 7 5 6 29
KSHIRSAGAR SONAL
A02310120 PRAKASH 8 7 7 8 8 33
- A02310121 | KUDALE SAGAR RAJARAM | AB AB AB AB AB AB
KSHIRSAGAR SONAL
A02310122 PRAKASH 8 9 9 8_ 7/3-\
- AO2310123 | KUDALE SAGAR RAJARAM 7 9 8 8 A" WED
S
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Anekant Education Society’s

Anekant Institute of Managements Studies (AIMS)

Baramati, Dist-Pune

Academic Year 2023-24

MBA —First Year, Batch 2023-25

SEMESTER I

Course Code & Title: (Add on Course 01) Information Technology

Result Sheet

Internal Evaluation Max Marks: 50

Roll No Name of the Student Total
50
A0O2310101 [ABNAVE RUTUJA SUNIL 31
A02310102 | AGAWANE RUSHIKESH SANJAY 31
A02310103 | ATTAR MUJEMIL ASHFAQ 31
A02310104 | BANKAR DHIRAJ RAMDAS 29
AO02310105 | BANKAR PRERANA PANDURANG 33
A02310106 | BHAGAT NIKITA RAJARAM 37
A02310107 | BHOSALE SHRADDHA DADADO AB
A02310108 | BHUNJE VAISHNAVI RAJENDRA 34
A02310109 | BORATE SIDDHI SATISH 27
AO2310110 | BULBULE KARTIKEY RAMAKANT 31
AO2310111 | CHAKHALE ASHISH KANTILAL 31
A02310112 | CHAVAN PRATIKSHA NITIN 29
AO02310113 | CHAVAN PRIYANKA SANDESH 39
AO2310114 | DHAPATE OM JANARDHAN 37
AQ02310115 | DHAVALE RAHUL MARUTI AB
A02310116 | DHAWAN SHITAL PRAMOD 39
AO02310117 | DHOTRE ADITYA ASHOK 31
A0O2310118 | DHUMAL PRATHAMESH SUNIL 33
AO02310119 | DOSHI ASHAY RAJKUMAR 29
A02310120 | KSHIRSAGAR SONAL PRAKASH - 38
AO02310121 | KUDALE SAGA_I& RAJARAM AB
A02310122 | KSHIRSAGAR SONAL PRAKASH 42
| A02310123 | KUDALE SAGAR RAJARAM 39
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Anekant Education Society’s
Anekant Institute of Managements Studies (AIMS) Baramati, Pune

Academic Year 2023-24
MBA —First Year, Batch 2023-25

SEMESTER 1
Course Code & Title: (Add on Course 01) Information Technology
Final Grade Sheet
Sr. No Name of the Student Internal | Internal Total Grade
Evaluation | Exam Marks
(100)
A02310101 |[ABNAVE RUTUJA SUNIL 31 35 66 B
AGAWANE RUSHIKESH
A02310102 SANTAY 31 33 64 B
A02310103 | ATTAR MUJEMIL ASHFAQ 31 40 71 A
A02310104 | BANKAR DHIRAJ RAMDAS 29 32 61 B
BANKAR PRERANA
A02310105 PANDURANG 33 37 70 B
A0O2310106 | BHAGAT NIKITA RAJARAM 37 40 77 A
BHOSALE SHRADDHA
A02310107 DADADO AB AB AB AB
BHUNIJE VAISHNAVI
A02310108 RAJENDRA 34 40 74
A0O2310109 | BORATE SIDDHI SATISH 27 28 55
BULBULE KARTIKEY
A0O2310110 RAMAKANT 31 32 63 B
CHAKHALE ASHISH
A02310111 CANTILAL 31 33 64 B
A02310112 | CHAVAN PRATIKSHA NITIN 29 38 67 B
CHAVAN PRIYANKA
A02310113  SANDESH ) 39 40 79 B
AO2310114 | DHAPATE OM JANARDHAN 37 42 79 0
AO02310115 | DHAVALE RAHUL MARUTI AB AB AB AB
A02310116 | DHAWAN SHITAL PRAMOD 39 38 77 A
A02310117 | DHOTRE ADITYA ASHOK 31 35 66 A
DHUMAL PRATHAMESH
A02310118 SUNIL o 33 25 58 C
AO2310119 | DOSHI ASHAY RAJKUMAR 29 32 61 B
KSHIRSAGAR SONAL
A02310120 PRAKASH 38 35 73 B
A02310121 | KUDALE SAGAR RAJARAM AB 35 35 A
KSHIRSAGAR SONAL
AO23_10122 PRAKASH 42 - 35 77 A
A02310123 | KUDALE SAGAR RAJARAM 39 40 79 0
AZATE pay
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Anekant Education Society’s
~—Anekant Institute of Managements Studies (Aims) Baramati, Pune

Academic Year 2023-24
MBA —First Year, Batch 2023-25

SEMESTER 1
Course Code & Title: (Add on Course 01) Information Technology

Feedback-Analysis—

Sr. No Parameters Average Rank
1 Syllabus contents 4.3 6
9 Usefulness to Management 4.5 4
| Students
3 Number of units and its 4.4 5
_sequence
4 Recent trends and concepts in 4.1 7
o the syllabus -
5 Size of syllabus in terms of the 45 4
load on the student
6 The evaluation scheme 4.3 6
B designed for each of the course -
7 Objectives stated 4.6 3
8 Practical’s/ Tutorial conducted 4.8 1
9 Course Relevance 4.7 2
10 Comprehensiveness 4.0 8
Overall Ratings 4.6

duration should be shortened.

R

Name of Faculty: Dr. Mk. Vhora

Students registered and attended gave a favourable response for this course. This can be seen as
the average calculated for the variables range from Poor to Excellent (5- Excellent; 4- Good; 3-

Neutral; 2- Satisfactory; 1-Poor). All Averages are above than 4. Students opined that course
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Student Feedback
AIMS, Teaching and Educational Standards Syllabus Feedback Form.

AIMS values feedback from stakeholders regarding syllabus and other curriculum matters as
part of its continuous improvement policy. To provide feedback please complete the
following feedback survey form.

Student Feedback Sheet for Add on Course

1. Please give the following details:

Name: Ngane.  pycehiterlh Sanioy

Address: U Bayeum oty s

Mobile No: qLIus"27432

Email 1d: 2L Shi agaven el@ gmei) - Coro
Designation: sShudert— 7 -

2. Following are the parameters of syllabus. Tick in the appropriate box on the basis of
your opinion on syllabus.

The scale is given below:

I'=Poor II= Satisfactory IIl=Good IV =VeryGood V =Excellent

Parameters 1 IImjmr|iv|v

Syllabus contents
Course is in relation to the competencies expected out of the
course. 1%

AN

Number of units and its sequence for each course v

Recent trends and concepts in the syllabus \

Size of syllabus in terms of the load on the student v

The evaluation scheme designed for each of the course

N

Objectives stated

Practical’s/ Tutorial conducted

|

5“.\090.\1.0\9.&9 SIS

L7
Course Relevance v
Comprehensiveness v’

3. Kindly write the area/subject/concept to be included/ updated in the syllabus.
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———ne
ZSTE OF 3
/ \
(:\TJ ____‘\.@-r\\

I/ ~ 4 Qq
ff* <F et
. le| (o, Mg, \n
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COURSE TEACHER: D¥ V1A . Vi oy DATE OF ADMISSION: 15 [0 q[202%
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/7

W

Signature of Course Teacher

LHehoen,
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Defining Information

* Whatis Information?

Information is any knowledge that comes to
our attention. That could be voice, image,
text and video

* Whatis data?

Data is information when dealing with the
machine

Introduction To Information
Technology

Methods for conveying information
e

What Counts as information

INFORMATION

|
v
)



Defining Information Technology

* Information Technologies are
systems of hardware and/or
software that capture, process,
exchange, store and/or present
information using electrical,
magnetic and/or electromagnetic
energy.

IT in Society (people)

* Personal Communication
- Conversatlons {phone, cell)
- Messaging (E-mall, SMS)
- Video Coms
+ Entertainment
- Web surfing
- Downloading video and audio files
~ Inleractive gaming
* Day-to-Day living
~ Buying airine tecket
- Ordering books
- Electronlc banking/ slock market

IT Example: Wireless Internet

B T I — Y
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Examples on IT Careers

Information Security Jobs
— Address Informatlon security

IT Analyst
— Translate bus' requ! Into technlcal specificati
Network Administration

- Configure and operaie computer network
Management Consulting

— Provide consulting for govemment and organizatlons
Database Administration

= Managing corporate database
Computer Forenslcs Expert

— Extracts computer evidence for detecting/preventing /prosecuting

cnmes

IT Sales:

~ people on frontline to sell products
Software development:

— develop software solutlons

IT in Society (business)

Internal Communication
— Computer network

- Corporate webslte

— Video leleconferencing
— Messaging (SMS, email)
Electronic Commerce

— Call Centres

- Eleclronic iransactions
— Online sales

* Business operations

- Factory operatlon systems
~ Dalabases




